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What you will do:

4 Start
FrontPage
2000.

4 Explore the
FrontPage
2000 main
window.

4 Start a Web
site by
creating a new
page.

4 Become
familiar with
the different
ways to view
your work in
FrontPage
2000.

Getting Your Bearings

FrontPage 2000 makes it easy for you and your students to create a
Web site. With FrontPage 2000, you can create the structure or layout
of your Web site, apply graphical themes to its pages, and organize its
files and folders. You can import and export files, test and repair
hyperlinks, track tasks, and design and edit the contents of your Web
pages. When your Web is completed, use FrontPage 2000 to publish it
on your computer, your organization's intranet, or the World Wide
Web.

As you add components such as text, images, tables, and form
elements, FrontPage 2000 displays them as they would appear in a Web
browser. Although it is a powerful tool, FrontPage 2000 is easy to use
because it looks much like a word-processor. You do not need to learn
Hypertext Markup Language (HTML) to use FrontPage 2000 because it
creates all the HTML code for you. You can click the HTML tab at the
bottom of the page to view and directly edit the code, and then click
Normal for “What you see is what you get” (WYSIWYG) format. Also, the
Preview tab lets you see what your Web site looks like in the browser.

Before you begin

To get an idea of how you want your Web site to look, it is a good idea
to look at outstanding Web sites that other people have created. Look
at these sites for good examples of Web design and organization.

• The United States Department of Education at http://www.ed.gov/

• The University of Washington at http://www.washington.edu/

• The United States Information Association at http://www.usia.gov/
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Several organizations give awards for outstanding Web sites. The
following two Web sites are examples of this type of Web site. Visit
them for examples of what Web users like to see:

• Best of the Web at http://www.botw.org/

• Internet Professional Publishers Organization at http://www.ippa.org

Starting FrontPage 2000

This lesson walks you through opening FrontPage 2000, viewing the
screens and toolbars, and creating your first Web page using FrontPage
2000. When you have finished this lesson, you will have a simple Web
site with a template attached.

To start FrontPage 2000

1. Turn on your computer.

2. On the Windows Taskbar, click Start, point to Programs, and
then click Microsoft FrontPage. FrontPage 2000 opens in Page
view.

Exploring the FrontPage 2000 Window

Finding your way around FrontPage 2000 is easy once you know the
location of folders and files and the navigational techniques. To give
you greater control over how your Web pages turn out, FrontPage
2000 offers six different views of the current FrontPage 2000 Web.
When you open FrontPage 2000 the first time, you see the Page view
window. The toolbars and scroll bar you see are available for all six
views.
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Working with the FrontPage 2000 toolbars

Three toolbars are available in Page view when you open FrontPage
2000 for the first time.

Views toolbar
Click to see
your Web site in
the different
available views.

Tabs
Click to see your Web page in
Normal (WYSISYG) format,
HTML coding, or a preview of
what the page looks like in
the browser.

Scroll bars
Use these to move up
and down or across
your Web page.

Standard toolbar
Formatting toolbar
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Menu toolbar

The Menu bar contains a list of menus that help you create, edit, and
format Web pages in FrontPage 2000. As you click each menu,
additional options appear. Each option shows you more choices,
depending on what you are doing. If a menu option looks faded (is
grayed out), the option is not currently available to you, but are
available for other activities. If you see a chevron  at the bottom
of the menu, click it and the rest of the menu options appear. The

options you use most are promoted to the top of the menu.

Standard toolbar

The Standard toolbar contains buttons that give you quick access to
FrontPage 2000's most commonly used functions, such as opening,
saving, and printing.

Click to create,
open, save, or
send a document
as e-mail.

Print a
document,
preview
printing, or
check spelling.

Undo or redo
any action.

Insert a
hyperlin
k.

Show or
hide
markers.

View the list
of folders
used in your
Web site.

Cut, copy, and
paste objects, text,
or styles.

Add
components,
create tables,
or add
graphics.

Refresh
the page
or stop a
jump.

Ask the
Answer
Wizard for
help.

Formatting toolbar

The Formatting toolbar contains buttons that allow you to format
text and paragraphs on your Web pages.

Format paragraph
styles on your Web
page.

Change
the font
size.

Right justify,
center, or left
justify text.

Highlight text or
change the font
color.

Explore the Menu toolbar by clicking on each of
the
menus. For example, click Tools to see the

Arrows indicate that there
are additional options for
this menu item.

The chevron means more
options are available.
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Change fonts on
your Web page.

Format fonts as
bold, italic, or
underlined.

Format text as a
numbered or bulleted
list, and move the
indentation in or out.

Creating a Web

A Web is any document or set of documents you can view on the World
Wide Web. A Web can be a single page or an entire Web site. Web pages
are individual HTML files that stand-alone and have their own address
(URL) on the Web. Web sites are related collection of pages, including a
beginning file called a home page. From the home page, you can
navigate to all other pages on the site.

Begin creating your Web site by building a home page in FrontPage
2000. This is the “front door” to your Web site and should include a
greeting, a short explanation of what the Web site is for, and links to
the rest of the Web site. For this exercise, you will create a school Web
site, so your home page is an introduction to the school and related
Web pages. You can then use the same skills to create a homepage for
a class you are teaching, whether you teach online or in person.

To start building a Web

1. Start FrontPage 2000 if it is not already open. When you
open FrontPage 2000, you see the Page view.

2. On the Standard toolbar, click the arrow next to the New
button and then click Web. The New dialog box appears.

3. On the Web Sites tab, click Empty Web, and then click OK. The
Folder list appears between the Views menu and the page.

4. On the Views menu, click . Because you have not yet added
any pages, the Navigation view is blank. Click  to add a
home page.

5. Right-click the home page icon and click Rename, then type
Central High School Home Page. This is the text that appears at the
top of the page.

Click the arrow next to the New
button.

Then, click the New Web button

Microsoft also
provides templates
for several types of
Web sites. Try
experimenting with
the templates to find
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6. To add connecting pages to your home page, click the home
page and then click  five time to add five pages. The pages
appear under the home page.

7. Right-click New Page 2, and click Rename. Type Calendar of

Events.

8. Repeat step 7 with the other new pages and name them
Departments and Faculty, Academic Requirements, Alumni Activities,
and Educational Links.

Adding tools to get around a Web

To make it easier for people to find information on your Web, add
navigational tools. The easiest way to do this is by adding shared
borders. Shared borders are regions that are common to one or
more pages in a web. A shared border may be a region at the top of
the page (similar to a page header), at the bottom (similar to a
page footer), at the left, or at the right. With shared borders, you
can easily add a logo or navigation buttons at the top of each page
because you must only add the information once and it appears on
all pages sharing the same border.

To add shared borders

1. From the Navigation view, double-click the Calendar of Events
page.

2. On the Format menu, click Shared Borders.

3. Select the All Pages option, then select the Top, Left, and
Bottom checkboxes.

4. Select the Include navigation buttons checkbox below the Left
option to add links to all the pages in your Web, and then
click OK. Dotted lines appear on the Web page to indicate
where shared borders are located.

5. Click in the top shared border area. The text is highlighted.

6. On the Insert menu, click Page Banner.

7. Select the Picture option, verify that Calendar of Events is in the
Page banner text box, and then click OK. The title Calendar of

Events can now be seen in the top shared border.
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8. Click in the left shared border area. The text is highlighted.

9. On the Insert menu, click Navigation Bar.

10. Select the Same level option, then select the Vertical, and Text
options and click OK. Hyperlinks to each of the Web pages
below the home page are now located in the left shared
border.

11. Click on the bottom shared border area. The text is
highlighted.

12. On the Insert menu, click Navigation Bar.

13. Select the Top level option, then select the Horizontal and Text
options and click OK. The title Central High School Home Page can
now be seen in the shared border at the bottom of the page.

You now have a very simple Web site with navigational links
between pages. With a Web site under construction, you can now
get to know each of the FrontPage 2000 views.
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Become familiar with the FrontPage 2000 views

Once you have a Web site under construction, you can view the site in
any of the six available views.

Page View. Create and edit individual pages. Page view also allows
you to see your content in Normal (WYSIWYG), Reveal Tags in
Normal, HTML, or Preview in browser views.

Folders View. View the organization of all the Web pages,
graphics, and files in your Web.

Reports View. See pages, graphics, and files in your Web, and run
reports listing slow pages, unlinked, errors, status, recently
added or changed files, broken hyperlinks, or categories for any
of the files.

Navigation View. Create navigation bars, view the navigational
layout of the site, preserve settings across editing sessions, and
zoom in to work on specific parts of the site.

Hyperlinks View. See all of the items that link to or from a specific
page or Microsoft Office document, and visually see if any links
are broken.

Tasks View. Track what tasks need to be done and to whom the
tasks are assigned, and quickly see the status, description, and
the priority of the tasks.

In the following sections you’ll get a more in-depth look at each of the
views and see how they help you work better as you build a Web site.
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Working with content in Page view

The actual writing of the Web pages occurs in Page view. You can
add content, add graphics, effects, and motion clips to pages, as
well as apply a theme and check spelling and grammar.

To explore the Page view

1. On the Views toolbar, click the Page button. You see the
current page you have been working on with the Normal tab
selected. You can edit a Web page in Page view much like
you would edit a document in Microsoft Word.

2. In the Folder List, double-click
central_high_school_home_page, click in the area to the
right of the left shared border, and then type Welcome to the

Central High School Home Page!. Select the text by dragging over
it with the pointer, and then click . If you do not see the
Folder list, click .

3. With the text still selected, change the font by selecting
Comic Sans MS from the Font drop-down list and change the
font size by selecting 4 (14 pt) from the Font Size drop-down
list

4. Click the HTML tab. This tab shows you the HTML code that
determines what the page looks like in the browser. If you

Dotted lines indicate
shared borders.

Text you add in the
active page with font
and size changed.

The hyperlink to the
home page that you
added.
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know HTML code, you can edit your Web page directly in the
HTML code.

5. Click the Preview tab. Here you see the Web page as it looks in
the browser. Use the scroll bar on the right to see the
bottom of the page.
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Organizing a Web with the Folders view

Folders contain the organization of the contents of files and folders
in the Web. You can create, delete, copy, and move them in the
Folders view.

To explore the Folders view

1. On the Views toolbar, click the Folders button. You see the
folders for your School Web site. Because you have not
created all the pages, you do not yet have many folders.

2. In the Folders List pane, click images.htm.

3. In the right pane, view the contents of the images folder.
Because you have not yet added any graphics to your Web,
this folder is empty.

As your Web site becomes larger and more complex, you will
see more folders in the Folder list and they will contain more
information. Examples of files that FrontPage 2000 adds to the
folder list include the following:

• Global.asa  contains information about the Web’s data
connection for use with database functions.

• Animate.js  contains Dynamic HTML animation effects.

Folder List
Shows the file
structure of the Web
folder.

Contents
Shows the selected
Web folder's
contents.
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• Fphover.class  contains hover buttons added to Web
pages.
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Retrieving information about your Web with Reports
view

All Webs contain a list of files in the project's folders. The list
provides information such as file names, sizes, types, number of
links, types of links, and modification dates.

To explore the Reports view

1. On the Views toolbar, click the Reports button. A list of report
topics appears in the left column.

2. Double-click Recently added files. The list of files you just
created appears.

3. Click Title to sort the hyperlinks by page title.

4. On the Views menu, click Reports, and then click Site Summary
to return to the summary page in the Reports view.
-Or-
On the Reports toolbar, select Site Summary from the Report
drop-down list.

Reports view alerts you to possible problems in your Web site. As
you continue to work on your Web site, the reports become
more useful. You are able to see broken hyperlinks in your Web
site, which pages take too long to download, and which tasks
are incomplete.

The name of the
report.

The number of
effected files.

The size of the files.

A description of the
report type.

The Reports toolbar
helps you move
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Maintaining site navigation with Navigation view

The Navigation view shows you a display of the structure of your Web.
You can create, display, and print this Web structure. If there is
more than one page box, you can click the + (plus sign) in the Home
page box to open it; if there is a – (minus sign), click it to close the
Home box.

To explore the Navigation view

1. On the Views toolbar, click Navigation.

2. Click the Central High School Home Page page. Notice that the
selected page is blue, while the others are yellow.

3. In the Central High School Home Page page, click - to collapse
the Web, then click + to expand the Web again.

4. Click and hold the Alumni Activities page, and then drag it
under the Calendar of Events page. Any changes you make in
this view effect the pages in Page view, so click and drag the
Alumni Activities page back to its original place.

5. On the Navigation toolbar, select 150% from the Zoom drop-
down list. Notice that you can view a select portion of the
Web and use the scroll bar to view the rest of the Web. You
can also select Size To Fit to view the entire Web, regardless
of how big it is.

The Navigation toolbar
allows you to view the
navigation structure at
different percentages.
Also, the external link
button on the Navigation
toolbar allows you to
add links to pages
outside your Web to
your navigation
structure.

The minus sign shows
you there are pages
below this page and that
all the pages are visible.

The navigational
structure of your Web is
represented with a tree
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6. From the Navigation view, you can also double-click a page to
see it in Page view.
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Managing hyperlinks with Hyperlinks view

In the Hyperlinks view, you can view the Web pages in the left pane
and the hyperlinks in the right pane. The page graphically displays
hyperlinks between pages, between files in your FrontPage 2000
Web, and from your Web to other sites on the World Wide Web.

To explore the Hyperlinks view

1. On the Views toolbar, click Hyperlinks.

2. In the Folder list, click central_high_school_home_page.htm.
This shows you all the links to and from the Web page.

3. In the left pane, click the + in front of
calendar_of_events.htm. This expands the view of hyperlinks
to that Web page. A page without a + or a - does not have
any additional hyperlinks.

4. Click the - in front of calendar_of_events.htm to close.

5. Right-click calendar_of_events.htm, and then click Move to
Center. This makes calendar_of_events.htm the center of the
Hyperlinks view.

Pages that link to
the selected
page.

The selected
page.

Pages to which
the selected page
links. A   (plus
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Monitoring tasks in Tasks view

With the Tasks view, you can generate and keep track of a list of
tasks to complete your FrontPage 2000 Web. You can create new
tasks, assign them to specific pages, and track their progress. Use
this view to display the status of Web tasks before you publish your
Web. Prior to your creating and assigning tasks, Tasks view is empty.

To explore the Task view

1. On the Views toolbar, click Tasks.

2. On the Standard toolbar, click the arrow next to the New
button and then click Task. The New Task dialog box appears.

3. In the New Task dialog box, type Create School Logo.

4. Type John Doe in the Assigned To box.

5. Under Priority, select the Medium option.

6. In the Description box, type find a school logo image, and then click
OK. The task appears in the Task view with a red dot next to it
to indicate that it is not yet complete. Green dots appear
next to completed tasks.

Click the arrow next to the New
button.

Click these buttons
to sort the tasks.

Each task appears
in the Task view
with a dot
indicating whether
the task has or has
not been
completed.
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Extending your knowledge

Many features of FrontPage 2000 are described in this book, and there
are many more that you can explore on your own. To learn more about
any feature in FrontPage 2000 use the Answer Wizard.

Exploring FrontPage 2000 Help

Use the FrontPage 2000 Help command to get online help. To answer
your questions quickly and efficiently, the FrontPage 2000 help
system has three parts: Contents, Index, and the Answer Wizard.
Contents is like a table of contents where help is organized by
chapters and subtopics. In Index, you type a keyword that you want
to find more information about. The Answer Wizard allows you to
ask a question using natural language, then generates a list of
topics that relate to your question.

To ask the Answer Wizard a question

1. Click  to open the Answer Wizard.

2. Type your question in the box that appears. For example,
type How do I publish my Web site?

3. Click Search.

4. Select the topic that most accurately answers your question.
The text appears in the Help window.

5. To close the Answer Wizard, click the X in the upper-right
corner of the Answer Wizard's box.

Viewing ScreenTips

In addition to the Answer Wizard, ScreenTips can be a helpful tool in
learning to use FrontPage 2000. When you position the pointer next
to any button on the toolbars, a small box appears with the name of
each button. The box is called a ScreenTip.

Point to any toolbar
button.

The Screen Tip appears.
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Closing FrontPage 2000

To make sure that you do not lose any work you have done with
FrontPageÊ2000, always follow the proper procedures to close
your file. If you plan to continue to the next activity in this book,
you do not need to close FrontPage 2000.

To close FrontPage 2000

1. Save your work by clicking Save .

2. On the File menu, click Exit.

3. If you did not save your work, click Yes to save.


